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Cliptures Reference - Windows

Welcome to Cliptures!
Thank you for choosing Cliptures electronic clip art. If this is your first Cliptures volume, please take a moment to review
this important information before using the Cliptures software.

Important - Opening Graphic Files
Cliptures graphic files are computer files. They are not programs. In order to use the graphics, you must have a software
program that can read one of the included graphics file formats. You cannot double-click on a graphic file and have it
start up your software program!

There is nothing you have to install!
This CD was designed so that you can use the graphics directly from the CD without having to install anything onto your
hard disk. The only time you have to copy any of the Cliptures files to your hard disk is if you are using a layout program
that requires you to have its CD inserted into your CD drive for the program to operate. If this is the case, you can copy a
Cliptures graphic, multiple graphics, or an entire Cliptures folder to your hard disk.

Copying Cliptures to your hard disk:
(Windows 95 or 98)

1. Double-click on the "My Computer" icon on your desktop.

2. In the "My Computer" window, double-click on the icon for your CD drive.

3. Use the same technique of double-clicking on folders to locate the Cliptures file or folder you want to copy to your
hard disk.

4. When you locate the file or folder you want to copy, click on it one time so that is highlighted (selected).

5. From that window's "Edit" menu, select the "Copy" command.

6. Close any open windows until you can see the main "My Computer" window.

7. In the My Computer window, double-click on the icon for your hard disk. This will normally be your C: drive.

8. From the "File" menu, select the "New" option and "Folder" from the sub-menu. This will create a new folder with the
words "New Folder" selected.

9. Type in the name you want the folder to have. You might want to use something like Cliptures or whatever you prefer.

10. Double-click on the icon for this new folder you just created.

11. With the window for the folder you just created still on top and the active window, select the "Paste" command from
that window's "Edit" menu. When you do this the file or folder you copied from the Cliptures CD in step 5 will be pasted
into the new folder you just created.

That's it!

Copying KoolKat to your hard disk:
You can also use the same technique to copy the KoolKat catalog to your hard disk. If you want to do this, copy the whole
_KoolKat folder to your hard disk, not just the files.

Note: The Windows help system has more information about other ways of copying files from one place to another. You
can access the Windows Help system by pressing the F1 key while your at the Windows desktop.
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What's included on the CD
We've included all of the graphics in multiple formats to insure that you will have a format that is compatible with most
major software programs and printers. The following formats are included:

EPS (Vector)

JPG (Raster)

WMF Hi-Res (Vector)

WMF Low-Res (Vector)

Bonus! Cliptures - KoolKat SE image catalog with WMF Hi-Res, color images.

Color and Black & White versions too!
We've included both color and black & white versions of the graphics in each of the formats. The black & white versions
are great when you need to create something that will be reproduced on a copier, for FAX cover pages, coloring book
pages, and craft projects too!

The Cliptures CD has 3 main folders:
1. _KoolKat - This folder contains the KoolKat catalog and the files it needs to operate.

2. Blk&Wht - This folder contains the black & white versions of the Cliptures graphics.

3. Color - This folder contains the color versions of the Cliptures graphics.

Cliptures - KoolKat SE image catalog!
As a bonus we've included a set of the WMF (Hi-Res) color images for this Cliptures volume in a special edition of our
KoolKat image catalog software. KoolKat is an easy way to add images to your layouts. You can open up the KoolKat
catalog, browse through the images, and "copy & paste", or, "drag & drop" an image from the KoolKat catalog into your
compatible software program's document.

System Requirements for KoolKat:

-Windows 95 or later

-At least a 486/33 or faster computer with at least 8 MB of RAM (You need to have enough memory in your computer to
be able to run KoolKat and your layout program at the same time.)

-A software program (that you are creating your layouts in) that supports color, vectored WMF format graphics that can
work with (in some cases) 100KB + file sizes.

Important note!

KoolKat is a program! While you are using a KoolKat catalog, you must keep the Cliptures CD with the KoolKat catalog
you are using in your CD-Rom drive. Before removing the Cliptures CD you must first quit the KoolKat program. If you
remove the Cliptures CD, and then try to do anything with a KoolKat catalog you left open, the KoolKat program will
crash!

Starting KoolKat:

1. Click on the "Start" button on your Task Bar.

2. Click on "Browse...". This will open the "Browse" window.

3. In the "Look In:" section, click on the arrow pointing down to the right of the window and then click on the drive letter
for your CD-Rom drive.

4. Double-click on the "_KoolKat" folder.
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5. Double-click on the "Clipture" file. This will select the KoolKat Clipture program and take you back to the "Run"
window.

6. When you are returned to the "Run" window, click the "OK" button.

How to use the KoolKat - Cliptures Catalog:
(Copy & Paste)

With "copy & paste", you select an image in KoolKat, click the camera icon to copy the image, make your other software
program active, and paste in the image. Here are the steps:

1. Open the software program you are creating your layout in and open a new or an existing document.

2. Start the KoolKat catalog program by running the Clipture.EXE program on the Cliptures CD. This will start KoolKat
and open the catalog.

3. Find an image in the KoolKat catalog you want to use in your layout.

4. Click the KoolKat camera icon to copy the graphic.

5. Switch over to your software program's document.

6. Select the Paste command from your software program's Edit menu and the graphic will be pasted into your
document!

(Drag & Drop)

With "drag & drop", you select an image in KoolKat, click on the image and while holding down your mouse button, drag
the mouse pointer onto the layout you are working on in your layout program. When you release the mouse button on
top of your layout, the image is automatically copied into the layout program's document.

Note: The Drag & Drop feature requires these things in order to work:

A. The program you are using to create your layout must support drag & drop.

B. The image must be of a compatible graphics format for KoolKat and the program you are dragging to.

If you try using drag & drop and it doesn't work with your program, try the "copy & paste" method.

 Here are the steps for using "drag & drop":

1. Open the software program you are creating your layout in and open a new or an existing document.

2. Start the KoolKat catalog program by running the Clipture.EXE program on the CD. This will start KoolKat and open
the image catalog for this volume.

3. Find an image in the KoolKat catalog you want to use in your layout.

4. Resize the windows for both KoolKat and your layout program so that you can see the picture that you want to use in
the KoolKat window and at least a portion of the other program's document that you want to copy the image onto.

5. Bring KoolKat to the front. (Make it the active program.)

6. Put your mouse pointer over the middle of the image in the KoolKat picture frame, then click and hold down the
mouse button.

7. Continue to hold down the mouse button and drag the mouse pointer on top of the document where you want to drop
the image.

8. With the mouse pointer over the document, release the mouse button and the image will be copied from KoolKat to
the other program's document!

Note: When using "drag & drop" with some programs, you may get a beep and a message from KoolKat saying: "This
field is not modifiable." If you do, just click the OK button and continue. What is happening is that the program you are
working with is trying to actually cut the graphic from the KoolKat catalog instead of copying it. Because the KoolKat
catalog is locked, KoolKat displays that message and keeps the other program from being able to remove the image.
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About the Graphic Formats:
As mentioned earlier, we've included all of the graphics in multiple formats to insure that you will have a format that is
compatible with most major software programs and printers. Below is a list of the formats that are included. The formats
are listed in the order that we recommend you try them followed by a brief description of the formats.

1. We suggest you try the KoolKat Cliptures catalog first. The catalog includes WMF - Hi-Res, color versions of the
Cliptures images. These are compatible with most programs and produce excellent results! The KoolKat catalog makes
accessing the images very easy!

2. If you prefer not to use KoolKat and would rather just import a graphic, use the WMF - Hi-Res version. Again, these
are compatible with most programs and produce excellent results.

3. If, for some reason, your program will not import one of the WMF - Hi-Res versions, try the WMF Low-Res file. These
are not quite as complex a file but they still look and print at a quality equal to or better than most other company's clip
art.

4. If you are working with a "paint" type software program, or, your program doesn't support WMF format graphics, try
the JPG - Raster version.

5. If you have a program that supports Illustrator, EPS format graphics, and, it will print or convert PostScript to print
with your color printer, use the EPS version. Canvas, CorelDraw and Micrografx Windows Draw all support these
graphics and work with color printers too.

Graphics formats included:

WMF - Hi-Res (Vector Format)

This format should work with the majority of software programs. The file sizes are a little bit larger than the Low-Res
versions, but the lines in the images are very very smooth! You can blow up one of the Cliptures images very large and
they still print with smooth curves.

The only program that we found that wouldn't read all of the Hi-Res graphics was PrintArtist. From our testing, it
appears that PrintArtist has a limitation on how large or complex a WMF file it will read. Our testing showed that to be
about a 90 to 100KB sized file. We recommend that you use the Hi-Res version even with PrintArtist and only use the
Low-Res version if PrintArtist will not import one of the Hi-Res versions.

KoolKat - Cliptures Catalog

The KoolKat catalog included with this CD includes a copy of the WMF Hi-Res, color versions of the Cliptures images.
We recommend you give the KoolKat catalog a try! You can browse the images, search by keywords, and quickly copy
and paste, or, drag and drop an image into your layout.

WMF - Low-Res (Vector Format)

As mentioned above, PrintArtist (and possibly some other program we haven't tested) may not be able to handle some of
the larger and more complex Hi-Res versions of the Cliptures images. If for some reason your program will not read the
Hi-Res version, try this one!

At smaller sizes these images will look almost identical to the Hi-Res versions. They are the same file format as the Hi-
Res version except the objects in the graphics are created with fewer control points than the Hi-Res versions. This makes
the images a little less complex and the file size slightly smaller.

JPG (Raster)

If your program will not use WMF - vector graphics, you should be able to use this format. Because they are a "raster"
graphic, the JPG images do not have transparent backgrounds. You can also use this version in "paint" programs like
PaintShop, Photoshop, and PhotoDeluxe. These programs will also allow you to apply special effects to the JPG graphics
that you cannot do with the other graphic formats.
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EPS (Vector)

Our original graphics are created with Adobe Illustrator. The EPS format included on the Cliptures CD is a slight
variation of that original Illustrator format. We've included this version for those that are using a software program that
can read and print PostScript format graphics.

This is a very high quality graphics format but unfortunately there are not a lot of software programs that can use it.
There are however some programs that can read this format and that can also print PostScript graphics with inexpensive
non-PostScript color printers. Canvas, CorelDraw and Micrografx Windows Draw are some programs that can and they
do an excellent job!

If you want to edit a graphic, and, you have a program that can open Illustrator EPS format files, this version will be a
easier to edit than the WMF version.

Vector versus Raster
Although there are probably a few hundred different types of computer graphic file formats, most fall into one of two
basic categories: "Raster" or "Vector". Because there are pros and cons to both formats in different situations and with
different software programs and printers, we've included versions of the Cliptures graphics in both formats to give you
the greatest flexibility.

A vector graphic is made up of a series of computer instructions that tell your software program and printer how to show
and print all of the individual objects, or, elements that make up the graphic. Vector graphics will usually have a
transparent background when used with most programs. This lets you overlap or layer graphics on top of one another
and also use the graphics on colored backgrounds. The resolution, or sharpness, of a vector graphic is determined by the
software program and printer that you are using. A vector graphic can be easily resized and will maintain it's sharpness
even at larger sizes. Vector graphics also have generally smaller file sizes than raster graphics.

A raster graphic is made up of dots (pixels) and every dot must have a color assigned to it. This not only includes the
dots that make up the image; it also includes some of the space around the edges of any irregular shaped image. Because
of this, raster graphics have a opaque backgrounds. This is not a problem unless you want to layer or overlap a raster
graphic on top of another image or colored background.

Raster graphics are created with programs like PaintShop and Photoshop. Pictures taken with digital cameras are also
raster graphics. Vector graphics are created with programs like CorelDraw, Adobe Illustrator, Canvas, and Micrografx
Windows Draw.

Want more information?

If you would like more information about KoolKat, the Cliptures graphics formats, software tips, etc..., please visit our
web site at:

www.CoolClipArt.com

Using Cliptures Images With Your Software Programs
Note: Dream Maker Software graphics are produced in industry standard graphics file formats with proven track records
of dependable and reliable results. If you are having difficulty using an image with a particular program, you should:

1. Check the program's user manual to confirm that it supports the graphics format you are working with.

2. Check the program's manual again to make sure you are using the program correctly.

3. If you are still having problems, or if you have questions about how to import or open graphics with your software
program, you should contact the technical support department for that particular program. You should contact that
software company for help and to make sure their program is functioning properly, and to make sure that you are using it
properly before contacting Dream Maker Software.
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Programs & Recommended Formats
The following list includes a variety of popular software programs and recommended formats to use with those
programs. Compatible formats are listed in the order we recommend for that particular program. This information
applies to current versions of these programs only. (Older versions may not have the same capabilities.)

PrintShop Deluxe (KoolKat, WMF Hi-Res)

PrintShop Ensemble II (KoolKat, WMF Hi-Res)

PrintShop Ensemble III (KoolKat, WMF Hi-Res)

PrintShop Premiere 5 (KoolKat, WMF Hi-Res)

Adobe Illustrator (EPS (AI88))

Adobe PageMaker (KoolKat, WMF Hi-Res, EPS)

Canvas (EPS, KoolKat, WMF Hi-Res)

CorelDraw (EPS, KoolKat, WMF Hi-Res)

Corel Print House Magic (KoolKat, WMF Hi-Res)

Corel WordPerfect (KoolKat, WMF Hi-Res)

DogByte Creative Photo Album (WMF Hi-Res)

DogByte Frame It (WMF Hi-Res)

Micrografx CreataCard (KoolKat, WMF Hi-Res)

Micrografx Windows Draw - Print Studio (KoolKat, EPS, WMF Hi-Res)

Microsoft Greetings Workshop (WMF Hi-Res)

Microsoft Publisher (KoolKat, WMF Hi-Res)

Microsoft Word (KoolKat, WMF Hi-Res)

Microsoft Works (KoolKat, WMF Hi-Res)

PrintArtist (KoolKat, WMF Hi-Res, WMF Low-Res. EPS)

PrintMaster (KoolKat, WMF Hi-Res)

Note: The Cliptures graphics are compatible with many additional programs that are not included in this list. If the
program you are working with is not included, you should check its user manual to see if it supports WMF, EPS, Adobe
Illustrator, or JPG format graphics. You can usually find information about this in the Index section of your software
program's user manual under "Graphics", or "Importing".

Program Tips
Importing graphics into programs.

The following provides basic information for opening or importing Cliptures images with a few popular software
programs. For detailed information about using and manipulating the images with a particular program, you should
consult that program's user manual. If your program isn't listed here, you should check its user manual to see if it
supports WMF, EPS, Adobe Illustrator 88, or JPG format graphics.

Note: If KoolKat is listed next to the program, we recommend you try it first. The steps for using KoolKat were included
earlier in this document.

Real Important Note: If the software layout program you are using requires that you have its CD in the CD drive in
order to run, you will need to copy the Cliptures graphic or graphics you want to use to your hard disk. The steps for
doing this were included earlier in this document.
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PrintShop Deluxe

(KoolKat, WMF Hi-Res)

1. Open a new or existing PrintShop document.

2. From PrintShop's "Object" menu, select the "Add" option and then "Import..." from the sub-menu. This will open the
"Import Graphic" window.

3. In the "Graphic Type" section, select the "Windows Metafile" option.

4. In the "Directories:" section, select the letter for your CD rom drive (probably [-D-] ).

5. Again in the "Directories:" section, double-click on either the "Color" or the "Blk&Wht" directory.

6. Again in the "Directories:" section, double-click on the "WMF-Hi" directory.

7. Locate the name of the Cliptures graphic you want to use and click the "OK" button.

PrintShop Ensemble II

(KoolKat, WMF Hi-Res)

1. Open a new or existing PrintShop document.

2. From PrintShop's "Object" menu, select the "Add" option and then "Import" from the sub-menu. This will open the
"Import Graphic" window.

3. In the "Graphic Type" section, select the "Windows Metafile" option.

4. In the "Drives:" section, select the letter for your CD rom drive (probably [-D-] ).

5. In the "Directories:" section, double-click on either the "Color" or the "Blk&Wht" directory.

6. Again in the "Directories:" section, double-click on the "WMF-Hi" directory.

7. Locate the name of the Cliptures graphic you want to use and click the "OK" button.

PrintShop Ensemble III

(KoolKat, WMF Hi-Res)

1. Open a new or existing PrintShop document.

2. From PrintShop's "Object" menu, select the "Add" option and then "Import" from the sub-menu.

3. Locate the name of the Cliptures graphic you want to use and click the "Open" button.

PrintShop Premiere

(KoolKat, WMF Hi-Res)

1. Open a new or existing PrintShop document.

2. From PrintShop's "Insert" menu select the "Image" option and then "Import" from the sub-menu.

3. Locate the name of the Cliptures graphic you want to use and click the "Open" button.

Adobe Illustrator

(EPS)

1. Start Illustrator.

2. From Illustrator's "File" menu select the "Open" command.

3. Locate the Cliptures graphic you want to use and click the "Open" button.

Note: Cliptures graphics can be modified with Adobe Illustrator.
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Adobe PageMaker

(KoolKat, WMF Hi-Res)

1. Open a new or existing PageMaker document.

2. From PageMaker's "File" menu select the "Place" command.

3. Locate the Cliptures graphic you want to use and click the "OK" button.

4. When you are returned to the PageMaker document, click on the upper left corner of where you would like the graphic
positioned on the page.

Canvas

(EPS)

1. Start Canvas.

2. From the "File" menu select the "Open" command.

3. For the "Files of Type", select "EPSF (*.eps)".

4. Select the Cliptures EPS format graphic you want to use and click the "Open" button.

5. In the EPSF Import Options window that pops up, select the "Create Canvas Objects" option.

Note: The EPS version of the Cliptures graphics can be modified with Canvas. Canvas will also let you print PostScript
graphics to non-PostScript printers with excellent results!

CorelDraw

(EPS, KoolKat, WMF Hi-Res)

1. Start CorelDraw.

2. From CorelDraw's "File" menu select the "Open" command.

3. Locate the Cliptures graphic you want to use and click the "Open" button.

Note: Cliptures graphics can be modified with CorelDraw. CorelDraw will also let you print PostScript graphics to non-
PostScript printers with excellent results.

Corel Print House Magic

(KoolKat, WMF Hi-Res)

1. Open a new or existing Print House document.

2. From the "File" menu, select the "Import" command.

3. Locate and select the Cliptures graphic you want to use and click the "OK" button.

Corel WordPerfect

(KoolKat, WMF Hi-Res)

1. Open a new or existing WordPerfect document.

2. From the "Graphics" menu, select the "Image" option.

3. Locate and select the Cliptures graphic you want to use and click the "Insert" button.
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DogByte Creative Photo Album

(WMF Hi-Res)

1. Open a new or existing Photo Album document.

2. From the "Graphic" menu, select the "Import" command.

3. Under "Files of Type" select "Windows Metafile (*.WMF)".

4. Locate and select the Cliptures graphic you want to use and click the "Open" button.

DogByte Frame It

(WMF Hi-Res)

1. Open a new or existing Frame It document.

2. From the "File" menu, select the "Import Art" command.

3. Under "Files of Type" select "Windows Metafile (*.WMF)".

4. Locate and select the Cliptures graphic you want to use and click the "Open" button.

Micrografx CreataCard

(KoolKat, WMF Hi-Res)

How to import an image into a CreataCard project:

1. Open a new or existing CreataCard project.

2. Click on the "Creative Workshop" button.

3. Click on the "Art Book" button.

4. Click on the "Import" tab.

5. Locate the Cliptures graphic you want to use and click on the "Paste Art" button.

6. Click on the "Close Book" button.

How to paste an image from KoolKat into a CreataCard project:

1. Select an image in the KoolKat you want to use and click on the Camera (copy) icon.

2. Open a new or existing CreataCard project.

3. Click on the "Creative Workshop" button.

4. Click on the "Paste" button on the left side of the screen and the graphic will be pasted into the project.
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Micrografx Windows Draw

(KoolKat, EPS, WMF Hi-Res)

(Use these steps to import a Cliptures graphic into a new layout or a layout you are already working on.)

1. Open a new or existing Windows Draw document.

2. From the "Insert" menu, choose the "Picture" option.

3. Locate the Cliptures graphic you want to use and click the "Open" button.

Note: If you want to edit the graphic, use the Cliptures EPS version. This program does a great job with all the formats
and prints the EPS versions to color ink jet printers with excellent results!

(Use these steps to open a Cliptures graphic in it's own file.)

1. Start Micrografx Windows Draw.

2. From the initial screen select "Open File", or once the program is started select "Open" from the file menu.

3. Locate the Cliptures graphic you want to open and click the "Open" button.

Note: If you want to edit the graphic, use the Cliptures EPS version. This program does a great job with all the formats
and prints the EPS versions to color ink jet printers with excellent results!

Microsoft Greetings Workshop

(WMF Hi-Res)

1. Open a new or existing Greetings Workshop document.

2. From the "What shall we do?" window, select the "Add text, a picture, or something else" option.

3. From the "What do you want to add?" window, select the "Something else" option.

4. From the second "What do you want to add?" window, click on the top blank button.

5. In the "Open" window, locate and select the Cliptures graphic you want to use and click the "Open" button.

Microsoft Publisher

(KoolKat, WMF Hi-Res)

1. Open a new or existing Publisher document.

2. From the "Insert" menu, select the "Picture" option and the "From File" option from the sub-menu.

3. Locate and select the Cliptures graphic you want to use and click the "OK" button.

Microsoft Word

(KoolKat, WMF Hi-Res)

1. Open a new or existing Word document.

2. Click on the area of the page where you want to insert the graphic.

3. From the "Insert" menu, select the "Picture" option.

4. Locate and select the Cliptures graphic you want to use and click the "OK" button.
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Microsoft Works

(KoolKat, WMF Hi-Res)

1. Open a new or existing Works word processing document.

2. Click on the area of the page where you want to insert the graphic.

3. From the "Insert" menu, select "Clip Art". This will open the Microsoft Clip Gallery window.

4. In the Microsoft Clip Gallery window, click the "Import Clips" button.

5. Locate and select the Cliptures graphic you want to use and click the "Open" button.

6. In the Clip Properties window, click the "OK" button.

7. In the Microsoft Clip Gallery window, select the graphic again and click the "Insert" button.

PrintArtist

(KoolKat, WMF Hi-Res, WMF Low-Res, JPG)

1. Open a new or existing PrintArtist document.

2. From PrintArtist's "File" menu select the "Import" command.

3. Under the "List Files of Type", select: "Metafiles (*.wmf)".

4. Locate the Cliptures graphic you want to import and click the "Open" button.

Note 1: As mentioned earlier, PrintArtist has a limit on the size and complexity of a WMF file that it will import. If the
WMF-Hi version does not work, try the WMF-Low or JPG versions.

Note 2: As of this writing, the colors PrintArtist will use in a WMF graphic are somewhat limited. It is not uncommon to
see some strange color changes in a WMF graphic imported into PrintArtist. If this happens, you can edit the colors
within PrintArtist (see your PrintArtist manual), or you might want to use the JPG version of the Cliptures image.
PrintArtist does not alter the colors in JPG images.

PrintMaster

(KoolKat, WMF Hi-Res)

1. Open a new or existing PrintMaster document.

2. From PrintMaster's "Add" menu select the "Picture..." option. This will open in the "Art Gallery" window.

3. In the menu for the Art Gallery window, under the "File" menu, select the "Open from Disk" option.

4. Locate the Cliptures graphic you want to import and click the "Open" button.

For more information about using Cliptures graphics with these and other programs, please visit us our web site at:

www.CoolClipArt.com
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Cliptures Technical Support
Dream Maker Software graphics are produced in industry standard graphics file formats with proven track records of
dependable and reliable results. If you are having difficulty using an image with a particular program, you should:

1. Check the program's user manual to confirm that it supports the graphics format you are working with.

2. Check the program's manual again to make sure you are using the program correctly.

3. If you are still having problems, or if you have questions about how to import or open graphics with your software
program, you should contact the technical support department for that particular program. You should contact that
software company for help and to make sure their program is functioning properly, and to make sure that you are using it
properly before contacting Dream Maker Software.

Technical support for Cliptures is available from Dream Maker Software via the internet at:

www.CoolClipArt.com

You can also e-mail us with your questions to: support@CoolClipArt.com

Telephone technical support is available to our Registered Users Monday through Friday between 9:00 AM and 4:00 PM
(Mountain Time) at (303)762-1001.

Dream Maker Software

925 W. Kenyon Ave. #16

Englewood, CO 80110

USA

Telephone: (303)762-1001

FAX: (303)762-0762

©1999 Dream Maker Software with all rights reserved. Dream Maker Software is a registered trademark of Dream Maker
Software. Cliptures, CoolClipArt, and KoolKat are trademarks of Dream Maker Software. All other brand and product
names are trademarks or registered trademarks of their respective holders.
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